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1. Introduction to FE fundinfo’s Self-Service Data Feed 
 

FE fundinfo‘s Self-Service Data Feed service gives direct, efficient and customised 

access to high-quality static and dynamic fund data and template files for thousands 

of funds from a single reliable online source. The Data Feed option supports 

download of a customised feed of openfunds fields as CSV, XLSX or ZIP file. The 

automated feeds are accessed through a simple self-service web interface allowing 

easy configuration and download of fund information. 
 

Fund data fields conform to the openfunds international standard for fund data 

characterisation (www.openfunds.org). openfunds is an efficient, cost-free 

standard which characterises typically used investment 
 

fund attributes, a list that today consists of over 600 identifiers (“OF-IDs”). Tip: online 

definition of all openfunds IDs (OF-IDs) can be accessed via this URL: 

https://www.openfunds.org/<OF-ID>. 
 

Example:  https://www.openfunds.org/OFST001000 (Fund Group Name). 
 

The feed has access to data from over 100,000 share classes from 800 fund houses 

currently hosted on the FE fundinfo database. Data fields supporting MiFID II, Target 

Market (provided by Fund Houses), and PRIIPs are also available. Feeds are accessed 

through a simple API interface allowing easy integration into Fund Distributor or 

Service Provider platforms and applications. 

 

2. How Data Feed works 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 1: Data Feed b lock diagram 

 
 
 

 

The Data Feed service is similar to FE fundinfo’s Document Feed service but focuses 

on delivery of static and dynamic fund data / template files only. Static fund data refers 
 
 

http://www.openfunds.org/
https://www.openfunds.org/OFST001000
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to the large number of static attributes used to describe an investment fund such as 

Fund Group Name, Umbrella Name, Fund Name, Fund Currency, ISIN, Fund 

Manager, Fund Domicile, etc. Refer to the latest openfunds fields list for the full list and 

descriptions. The feed does not contain non-static data such as NAV or performance 

data. The feeds can be configured to update either daily, weekly, monthly, or quarterly. 

On the other hand, dynamic fund data refers to values regarding a specific point in 

time, a period or historised data. 

 

3. Accessing the Data Feed webpage 
 

The Data Feed is accessed via a web interface located online at: 
 

https://datafeed.fundinfo.com/ 

 

The homepage is shown in the figure below:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 2: Data Feed homepage 

 
 
 

 

Data Feed consists of two areas accessed by two tabs: 
 
 

• Home: brief description after logging in is available 
 

• Feeds: login and access to the self-service Data or File Feed configuration panels  
 
 
 
 
 
 

https://www.openfunds.org/fieldmenu/fields/
https://datafeed.fundinfo.com/
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4. Register for Data Feed 
 

Clicking on “Feeds” or the “Login” link in the upper right corner brings you to the log-in 

and registration screen. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 3: Click on "Feeds" to log-in 

 
 
 

If you are not yet registered, you can click on the Register tab and fill in your details.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 4: Fill in your details for registration  
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5. Logging in to Data Feed 
 

Clicking on “Feeds” or the “Login” link in the upper right corner brings you to the log-in 

screen. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 5: Logging in to Data Feed 

 
 
 

 

Enter your email address and password that were configured when you registered. 

Note that the email address you selected for your log-in is also the email address 

where you will receive notification when your feed is ready should you choose the 

email notification option. 

 

 

6. Feeds Overview page 
 

After your log-in is authorised, you arrive at the Feeds Overview page. There are 

several feed types you can create. When you log in for the first time, you will see the 

feed types you are activated for. An overview of the different user roles and the 

corresponding permissions can be called up here: 

https://datafeed.fundinfo.com/User/UserRoles/ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 6: Feeds overview page with Public File  

 
 
 
 
 

https://datafeed.fundinfo.com/User/UserRoles/
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For each feed type there is a so called Public File. The Public File is a predefined 

spreadsheet. This spreadsheet is available for downloads. The purpose is to 

illustrate the output of Data Feed and to illustrate its functions. You are able to modify 

configurations in the Public File Feed, but you cannot save them. 
 

In the following, the feed types Static are used to explain how Data Feed works. This 

handling is also valid for all other feed types. The different feed types are explained in 

chapter 9. 

 

To create your first Data Feed, click on “Create” under the appropriate tab. The feed 

types are independent of each other, you may create feeds of one or other types. As a 

first example, we will click on the “Static” tab and create our first static data feed. We 

will name it “My first feed”. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 7: Creating your first data feed 
 
 

 

When creating a new feed, you may want to make a variation of an existing feed. 

Instead of having to re-define a new feed from scratch, you can create a new feed by 

cloning an existing one. Going back to the “Feeds” tab, click on “Create”, then choose 

an existing feed to create a clone from the pull-down menu. Just click on the drop down 

and chose the respective Feed from the list. The new feed will have the exact same 

parameters as the feed you cloned it from. You are now free to modify this new feed as 

you wish. 
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7. Main Tab of data feed configuration dialogue 
 

After creating a new feed, the configuration page of the feed appears: 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 8: Main tab of the feed configuration dialogue 

 

The three fields configure what OF-IDs you will receive for which funds or share 

classes: 
 

 

7.1 Select fund groups 
 

Clicking in this field automatically opens up a pull-down menu where you may select 

one or multiple fund houses. For each fund house selected, all of their funds and share 

classes will be added to your feed. Note that you may leave this field blank if you are 

only interested in specific ISINs (described in the next section). Select only the fund 

houses whose funds you are interested to receive data about. The selection of a fund 

house will not only include all of their ISINs in the feed, it will also dynamically update 

the feed as new ISINs are added or existing ones removed over time. Note that as a 

Basic User of FE fundinfo's Data Feed service, you only have access to funds from a 

limited number of Fund Houses and Data Fields. Business Users have complete 

access to all fields and share classes. Contact Customersupport@fefundinfo.com for 

details about becoming a Business User. 
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Figure 9: Selecting fund groups to add to your feed 

 

 

Clicking on the “i” icon on the right gives you a brief explanation of each corresponding 

field. Clicking on the gear icon on the right gives you the option to select all fund 

houses, select all free fund groups, or to clear all entries in the field. 

 

7.2 Uploading ISINs 
 

Alternatively, if you already have a list of ISINs that you want to enter into the 

system, instead of checking “Fund Groups”, check “Uploading ISINs”. This will let 

you browse and upload a list of up to 10 thousand ISINs for Basic Users and up to 30 

thousand ISINs for Business Users from a file in CSV or XLSX format. The “Fund 

groups” and the “Uploading ISINs” options are mutually exclusive and cannot be 

mixed. Note that your uploaded selection is static and will not change even if the 

corresponding share class is liquidated. 
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Figure 10: Uploading ISINs option: import a list of up to 30 thousand ISINs 

 
 
 

 

7.3 Fields in feed 
 

This field is where you select the OF-IDs you wish to receive for all the ISINs selected 

in the first two fields. You may type or paste a list of openfunds OF-IDs here. 

Alternatively, clicking in this field automatically opens a scrollable menu where you can 

choose which OF-IDs you wish to receive in your feed. You may select as many as you 

want. The gear icon on the right gives you additional selection choices: 

 

• Select all: adds all OF-IDs to the field. Note that this will result in a very large 

file. It is recommended to only include the OF-IDs that you require. 
 

• Select by OF-ID: opens a grouped menu of OF-IDs for manual selection based 

on multiple check-boxes. Note that this selection is only available for Business 

User. 
 

The final 3 choices allow you to select MiFID II, Target Market and PRIIPs data fields.  
 
 
 
 
 
 
 
 
 
 

 
Figure 11: MiFID II, Target Market and PRIIPs fields options  
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• MiFID II fields: selecting this option will add all MiFID II relevant fields to 

your selection.  
A draft list of all available MiFID II fields can be found on the openfunds 

website. 
 

• Target Market fields: selecting this option will add all Target Market fields 

available for the funds and share classes you selected. Note that this data is 

only available if the Fund House has provided it. It may take some time 

before all Fund House provided Target Market data is available. 
 

• PRIIPs data: selecting this option will add all available PRIIPs fields to your 

selection. A draft list of all available PRIIPs fields can be found on the 

openfunds website. 
 

 

7.4 Frequency of production 
 

The final selection parameter in the main tab designates how often the data feed is 

updated. You should choose the lowest update rate which is suitable for your needs, 

either on a daily, Friday nights (UTC+0), last night of the month (UTC+0), or last 

night 
 
 
 
 
 
 

Figure 12: Configuration of production frequency and time 
 

 

of the quarter (UTC+0). Updates for all options are performed overnight after 8 PM 

CET. Exact time may vary depending on processing load. There is the possibility to 

choose the earliest production time of a feed. The feed will be produced as close as 

possible to the time you specified. However, it could happen that the feed is 

created 

some hours later due to high load. Selecting “None” deactivates feed production. 

 

7.5 Save your selection 
 

Once all parameters in the Main tab are completed, press the “Save” button. This 
 

saves your feed allowing you to recall and edit it later. As a Basic User you may 

define and save five feeds for each feed type. As a Business User you may define 

and save as many feeds as you wish. You are now ready to continue to Filter tab. 

 

 

 

 

 

 

 

 

https://www.openfunds.org/fieldmenu/fields/
https://www.openfunds.org/fieldmenu/fields/
https://www.openfunds.org/fieldmenu/fields/
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8. Filter tab of data feed configuration dialogue 
 

The Filter tab of the feed configuration dialogue is optional. It allows you to apply 

additional filters to your selection based on high-level criteria such as fund domicile, 

filtering out only ETFs or fund of funds, or filtering out only those funds that are 

registered for sale in particular countries, etc. 

 

Note that a default filter is applied so that only active funds are included in your feed. 

If your system needs to and is able to handle inactive funds, you may delete this filter. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 13: Filter tab of data feed configuration  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 14: Additional filters which may be applied 
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Where sub-selections are possible such as countries of registration, an additional 

pull down filter will appear allowing you to fine tune the filter settings . 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 15: Sub-selection menu example 

 

Click on “Save” to continue to the final configuration tab.  
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9. Format tab of data feed configuration dialogue 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
Figure 16: Format tab of data feed configuration dialogue 

 

The Format tab gives you options to format the feed output for compatibility with your 

preferred interface format: 

• Name: This is already populated with your feed name. You may change the 

name of your feed here if you like. 
 

• FileName: This is the actual filename of the feed. You may overwrite the default 

name here if you wish. 
 

• File Type: This allows you to designate the file type of the feed 
 

• Separator: This allows you to designate the field separator in the feed, either 

semicolon (;), comma (,), tab (\t), or pipe (|). 
 

• Encapsulation: This allows you to designate either single or double quotes for 

encapsulation of text strings in the feed. 
 

• Decimal Mark: Allows you to designate either a dot or a comma as the decimal 

mark in your feed. 
 

• Encoding: Allows you to designate the encoding of the feed, either UTF-8 

(BOM), UTF-8, ACSII, or Unicode. 
 

The following check boxes are also available: 
 

• Include OF-ID Field Names in Header (2
nd

 Row): checking this option will 

cause the openfunds field names to appear in the second row of the header  
 
 
 
 



Sel f Serve Data  Feed User Guide                                                                                                               Page  15 

 

 

(header row one contains the openfunds data-ID). This option is included to 

make the output more human-readable. 
 

Note that a quick link to individual openfunds field descriptions can be found 

by inserting this URL syntax in any internet browser: 

https://www.openfunds.org/<OF-ID> 
 

Example: if you would like to see the openfunds description for OF-ID 

“OFST160100”, just use the following hyperlink: 

https://www.openfunds.org/OFST160100 
 

• Email notification when new data feed is generated: checking this option will 

instruct the system to send a message to your email address (the one used in 

your log-in) when the feed is generated and ready for download. It will include a 

download link. If you want multiple email addresses to be notified, contact FE 

fundinfo at Customersupport@fefundinfo.com. 
 

• Generate delta file: checking this option will generate a delta file. In order to 

not produce the full file for every change, a delta file can be generated. In 

the delta file is only this data listed which have changed. 

• Append file generation date and time to the filename 

Checking this option will ensure that the generated file name will have the 

date and time appended to it. 
 

• Restrict IP Range: The IpRangeFilters is a field where you may specify IP 

addresses which are authorised to receive the feed. You can designate a 

single IP address, range of IP addresses separated by a comma, or a range of 

IP addresses in CIDR notation. If your device is part of an enterprise network, 

please contact your system administrator. If your device uses dynamic IP 

addresses, contact FE fundinfo at Customersupport@fefundinfo.com. 

 

9.1 Generating the feed 
 

Once these final options are selected, click “Save” to store all your feed preferences, 

then click on “Sample (10 Lines)”. Note that you must save your feed preferences 

before the generate button becomes functional. 

 

Because generation of the entire feed may take some time depending on how loaded 

the system is, the first 10 lines of the feed will be provided for download as a 

confirmation that your feed request has been accepted for processing. Click on the 

downloaded file and select “Save” and “Open”. The sample will generally open in 

Excel. The first 10 entries will appear exactly how they will appear when the 

complete feed becomes available. 

 

Once the entire feed is ready (typically generated after 8 PM CET) it will be available 

on the Feeds overview page via the first two URLs listed under “Files” The first is a 
 
 

https://www.openfunds.org/OFST160100
mailto:Customersupport@fefundinfo.com
https://en.wikipedia.org/wiki/Classless_Inter-Domain_Routing
mailto:Customersupport@fefundinfo.com
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CSV or XLSX file depending on your configuration, the second is a zipped version of 

the CSV or XLSX file. You may click on these links to download the file. You will also 

receive a confirmation email when the feed is ready (if this option is selected), else you 

may see in the format tab that the feed is ready by viewing the file size of the feed 

which will be greater than 0 KB after the feed is generated, as well as by seeing a 
 

timestamp entry in the “Last Generation (UTC+0)” field. If you selected the “Generate 

delta file” option, you will get a third URL with the Delta file. 

 

The feed will continue to be generated according to the selected frequency until 

you stop the feed by returning to the Main tab and selecting “None” in the 

“Frequency of production” fields followed by pressing “Save”. If the feed is not 

downloaded for a longer time, the “Frequency of production” sets automatically to 

“None”. 

 

At the bottom of the Format tab, last access to the feed configuration pages, number of 

feeds downloaded, the number of times a feed has been generated, and the date of 

the most recent feed generation are indicated. 
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10. The different Feed Types 
 

The following feed types are available on Data Feed: 
 

• Static: This feed type consists of static data. Static fund data refers to the large 

number of static attributes used to describe an investment fund such as Fund 

Group Name, Umbrella Name, Fund Name, Fund Currency, ISIN, Fund 

Manager, Fund Domicile, etc. 
 

• Document: This feed type contains URLs to documents such as KIDs, 
prospectus, annual reports, etc. These URLs may be added in any location and 

as often as desired in your internal applications. The URL always points to the 

latest version of a document. 
 

• Dynamic As-Of Latest: These feed type consist of a few static data ‘reference’ 

fields required for allocation of dynamic data, and those dynamic data fields 

being characterised as an ‘as-of’ related value. Typically, they refer to a 

specific point in time (e.g. ‘today’ or ‘yesterday’), but not to a period longer than 

one day. Typical examples are fund prices such as NAV (Net Asset Values). 
 

• Dynamic As-Of History: Unlike the other types, this feed type exists in ‘narrow 
formatting’ only, as it is built to report a large amount of data. Every data point is 

linked to a specific ‘as of’ General Reference Date. 
 

• Dynamic Period: This feed type consists of a few static data ‘reference’ fields 

and those dynamic data fields which are characterised as being a ‘period’ 

related value. This means that they do not have a single specific date, but 

refer to a precise period. Typical examples are ex-post cost-related data fields 

(e.g. those required by MiFID regulations). 
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• Orig. EMT/EPT: This feed contains URLs to the original regulatory files i.e. 

EMT, EPT, CEPT, DCPT 
 

• EMT v3.0/V3.1 
This feed type contains EMT v3.0 and EMT v3.1 data in FinDatEx format 

 
• WMDaten Adapter: This feed type converts openfunds to the WMDaten format. 

This type consists of three files KTF, ZMF and KVG. The generated file does 

not contain the OF-IDs but the field names of WMDaten. 
 

• EMT Adapter: This feed type converts openfunds to the EMT format. The 

generated file does not contain the OF-IDs but the field names of the EMT. 
 

• EPT Adapter: This feed type converts openfunds to the EPT format. The 
generated file does not contain the OF-IDs but the field names of the EPT. 

 
• Video: FE fundinfo provides a video upload service. The videos shall contain 

market and product news. With the Video feed you get among others the URL 

of the video to publish it at your desired websites and platforms. 
 

• News: This feed type is not a self-service feed but is listed here for the sake of 

completeness. This service enables asset managers to dispense investment 

and product related news to fund distributors. The news content body in a feed 

includes HTML formatting elements for the integration into your desired 

webpage without great efforts. The content is fed daily from FE fundinfo’s 

centralised news database into distributor’s information system. 

 

• EMT v3.0/V3.1 Openfunds 

This feed type contains EMT v3.0 and V3.1 data in the Openfunds format 

 

• EPT Openfunds 

This feed type contains EPT data in Openfunds format 
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11. Document Feed Service 
 

In addition to Data Feed, FE fundinfo provides API gateway access to all legal 

documents (KIIDs, prospectuses, annual and semi-annual reports etc.) and all 

marketing documents (KIIDs, fact sheets, fund profiles etc.) for investment funds. The 
 

service, “Document Feed” is described in a separate manual, “Document Feed – 

Document integration for fund distributors”, document number document_feed_(cs-p-

en-010001). Please contact FE fundinfo for details. 
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Contact information 
 
 

FE fundinfo 
Staffelstrasse 12 
8045 Zürich 
Switzerland 

Office Hours Switzerland: 
08:30 – 17:30 UTC +1 (daylight saving: UTC +2) 
Phone +41 44 286 91 02 
customersupport@fefundinfo.com 

FE fundinfo 
Rheinstraße 13 
60325 Frankfurt 
Germany 

Office Hours Germany: 
08:30 – 17:30 UTC +1 (daylight saving: UTC +2) 
Phone +49 69 750 859 790 
customersupport@fefundinfo.com 

FE fundinfo 
2nd Floor Golden House 
30 Great Pulteney Street 
London W1F 9NN 

Office Hours UK: 
08:30 – 17:30 UTC (daylight saving: UTC +1) 
Phone +44 203 451 50 38 
customersupport@fefundinfo.com 

FE fundinfo 
149 rue Saint Honoré 
75001 Paris 
France 

Office Hours France: 
08:30 – 17:30 UTC +1 (daylight saving: UTC +2) 
Phone +33 170 361 722 
customersupport@fefundinfo.com 

 

FE fundinfo 
Via Pola 11 
20124 Milan 
Italy 

Office Hours Italy: 
08:30 – 17:30 UTC +1 (daylight saving: UTC +2) 
Phone +39 02 3031 6294 
customersupport@fefundinfo.com 

 
FE fundinfo 
Paseo de la Castellana 259 C 
28046 Madrid 
Spain 

Office Hours Spain: 
08:30 – 17:30 UTC +1 (daylight saving: UTC +2) 
Phone +34 91 414 7805 
customersupport@fefundinfo.com 

 

FE fundinfo 
21st Floor Central 88, 
88-98 Des Voeux Road Central 
Hong Kong 

Office Hours Hong Kong: 
08:30 – 17:30 UTC +8 
Phone +852 3905 1088 
customersupport@fefundinfo.com 

 
FE fundinfo 
16 Raffles Quay 
Hong Leong Building #33-03 
Singapore 048581 

Office Hours Singapore: 
08:30 – 17:30 UTC +8 
Phone +65 3163 2294 
customersupport@fefundinfo.com 

 

   
 

Disclaimer 
 

The contents of this document are provided “as is”. This information may contain technical inaccuracies, typographical errors 

or out-of-date information and may be updated or changed without notice at any time. In no event shall fundinfo be liable for 

special, indirect, incidental or consequential damages resulting from or related to the use of this document.  
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